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MindManager®

MindManager for Windows large-scale
deployment (online mode)

This section provides information about large-scale Windows deployments in online mode.

This section contains the following topics:

e “Notes on deploying in online mode” (page 4)

* “System requirements for MindManager for Windows installation” (page 4)
* "Deployment strategies” (page 5)

e “What gets installed” (page 6)

*  "Registry keys” (page 8)

*  "What remains after uninstallation” (page 9)

e "Use the Admin setup” (page 11)

* “Deploy with the Installation Wizard” (page 12)

e "Deploy from the command line” (page 16)

e "Deploy with Active Directory” (page 26)

*  “Administer MindManager” (page 27)

e "Manage MindManager Apps” (page 34)

e “Treat UNC Paths as SharePoint servers” (page 37)
=<

Throughout this document, add-ins specific to 32-bit versions of Windows 10 have 32 appended to the end of the add-in name;
those specific to 64-bit versions of Windows 10 and Windows 11 have 64 appended to the end of the add-in name.

For legal information regarding MindManger's use of third-party software, see MindManger Legal Terms and Conditons.The
ThirdPartyReadMe can also be found in the installation directory:

* C:\Program Files\MindManager VN\THIRDPARTYREADME.txt (where VN is the application’s version number)
MindManager Support Help

For technical support with this product, go to http://www.mindmanager.com/support. Here you will find links to the Knowledge Base
articles, User Forums, and other online resources. You can also submit a support request for additional assistance.

MindManager for Windows large-scale deployment (online mode) | 3


https://www.mindmanager.com/en/company/legal/ 
https://www.mindmanager.com/en/support/

Notes on deploying in online mode

Deprecated command-line parameters

For online deployments of MindManager 22 and later, the availability of the following features is controlled through the MindManager
Customer Admin Portal:
* Online Storage Providers (Places)

* OneDrive

* SharePoint

* Box

* Google Drive

* Dropbox
* Publishing
» Co-Editing

*  MindManager Snap

The command-line parameters to disable these features during installation have been deprecated.

License key

As of MindManager 21.1 and later, packaging a license key through the LICENSEKEY command-line parameter is supported. For more
information see, “To configure installation parameters from the command line” on page 17.

MindManager Windows admin builds can be deployed with a license key. This optional parameter allows end users who create an
account and sign into the product to consume a license if they do not already have a license allocated to their user account. Admins still
have the option of administrating licenses to using the Admin Portal. For more information, go to the MindManager Account & License
Administration section on the MindManager Enterprise Downloads page.

MicrosoftEdgeWebview2Setup.exe

To enable enhanced embedded browser support based on Microsoft’s Chromium Edge Browser, install the Microsoft WebView2 Runtime.

System requirements for MindManager for Windows installation

Requirements

* IBM® or compatible Pentium® processor (1.6 GHz or greater)
* 4 GB RAM or greater

* 1.5 GB disk space

*  Recommended Minimum Display: 1280 x 720 pixels

*  Microsoft .NET 4.8 or higher

Supported operating systems

*  Microsoft® Windows® 10 32-bit and 64-bit

*  Microsoft® Windows® 11 64-bit

* Large Scale Deployments — Microsoft Windows Server 2016 64-bit and later

Additional requirements to use certain features

¢ Microsoft Office Professional 2016 or later (32-bit and 64-bit)

* Microsoft Project® 2016 or later (32-bit and 64-bit)

*  Microsoft SharePoint 2016 or 2019 Enterprise, Standard and Foundation servers
* SharePoint Online
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*  Microsoft Edge and Microsoft Edge WebView?2

Deployment strategies

This section provides an overview of different deployment strategies, including their basic technologies, advantages, limitations, and their
level of support.

Running the standard setup manually or automatically

You can deploy MindManager on a machine-by-machine basis using the standard setup (MindManager . exe) or from a centrally accessible
server. The standard setup is robust, interactive, and user-friendly, but does not support customized deployment.

Using the standard setup has these advantages:

* MindManager installs and operates properly on supported systems.

* |t requires no additional software or server resources.

* Users with local administration privileges can manage the update process individually.

And these disadvantages:

* Manual installation is time-consuming.

* The installed software uses up disk space on each user's system.
* Centralized administration becomes more difficult.

Running the Admin Setup manually or automatically

The MindManager Admin setup provides more control over installation and administration. You can run the Admin setup from a server
manually, or via a log-on script. If you use Windows Active Directory, Group Policy, and IntelliMirror, you can install on groups of user
systems.

Using the Admin setup has these advantages:

* MindManager installs and operates properly on supported systems.

* |t requires no additional software or server resources.

* You can customize installations on a per-group or per-user basis.

* You can run the installation silently.

* The installer is not cached on the client machine, reducing the required disk space.

And these disadvantages:
* Access to the original installer is required for repair and other setup operations.

Other deployment options
Deploying with Active Directory

This method is not yet fully supported. Due to the application architecture, MindManager only supports Computer-based Software
installations via Active Directory. User-based deployment is not supported. Using a third-party tool such as Orca allows you to edit properties
for deployment. For more information, see “Deploy with Active Directory” on page 26.

Using system management software and a custom setup

System management software, such as Microsoft System Management Server, enables you to centrally install and administer client machines.
While you can deploy MindManager using such software, there is no specialized support for this in MindManager. This document supplies
much of the information you will need if you choose to deploy in this way.

Using system management software has these advantages:

* You can deploy the software to many machines with one command.
* You can create different setups for different groups of users.

* Updating the software is simple.
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And these disadvantages:

*  You must have system management software in place.

* [t takes time to create the custom setup.

* The installed software uses up disk space on each user's system.

What gets installed

The Admin setup includes:

* Required program files

* Configurable components

* Shortcuts and Start Menu items

* Third-party add-ins or components
* Shared system software

* Registry keys

The default location for required program files is:
* C:\Program Files\MindManager VN
(where VN is the application’s version number)

This folder contains MindManager . exe, application DLLs, and third-party components. No user files are stored in this folder.

MindManager uses merge modules to install required system software, such as ATL80.d11. If MindManager uses a later version of a
component than one already installed on the machine, MindManager installs the required version during deployment. For more information,
“Shared system software” on page 7.

The first time a user runs the application, user data is placed in the default location:

C:\Users\ [username] \AppData\Local\Mindjet\MindManager\VN, where username is the current user name and VN is the
application’s version number. You must enable viewing hidden files to see this directory.

MindManager stores maps at this default location:

C:\Users\ [username] \Documents\My Maps

MindManager components

The application installs a variety of configurable components, including:
e Llibrary
* Dictionary

User configuration files are also installed to help govern their behavior.
Library

The Library component consists of several sub-components:

* Background Images: a library of map background wallpapers

* lcons: a library of symbols to indicate, at a glance, the status of an item

* Images: a library of pictures to help make maps more memorable

* Map Marker Lists: the library of user-created collections of map markers

* Map Parts: a library of insertable topic structures

* Shapes: a library of different topic shapes

* Styles: a library of MindManager map themes to customize the map’s overall appearance
* Templates: a library of map templates to provide a jump start on map creation

* Web: a library of web templates to format web pages

These are optional but highly recommended components.
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The library is not uninstalled if you uninstall the application; this content is preserved for users upgrading to newer versions.

The default location for the Library is: C: \Users\ [username] \AppData\Local\Mindjet\MindManager\VN\Library
\ [language] where language is ENU (English), FRE (French), GER (German), ESP (Spanish), JPN (Japanese), NLD (Dutch), or CHS
(Chinese Simplified), and VN is the application’s version number

You may wish to install the library to a different location. For instructions, see “Deploy with the Installation Wizard” on page 12 or
"Deploy from the command line” on page 16.
User configuration files

MindManager creates and stores user configuration files for different purposes.

Filename Location and function
ImagePropertyDatabase.dat C:\Users\ [username] \AppData\Local\Mindjet
\MindManager\VN

(where VN is the application’s version number)

The application runtime, not the installer, creates this file
dynamically. It collects information about keywords assigned by the
user to images.

UserData.ini C:\Users\ [username] \AppData\Local\Mindjet
\MindManager\VN

(where VN is the application’s version number)

This file detects the first time a user launches the application and
initiates procedures such as registry cleanup.

Library.in C:\Users\ [username] \AppData\Local\Mindjet
\MindManager\VN\Library\ [language]

(where VN is the application’s version number)

This file detects the library installation time. Because the application
installs the library the first time it is launched, this file prevents
multiple library installations.

Shared system software

Some shared software must be installed on your system before using the Admin setup. During installation, MindManager uses merge
modules to install other missing software, such as PIPanel.msm. Missing components are installed from the modules. Depending on the host
machine’s configuration, the merge module installs the components required for that machine.

These shared components are not uninstalled automatically. Their default locations are indicated below.

Component Folders and files

Ink-related files $CommonProgramFiles%\Microsoft Shared\Ink
* InkObj.d11l
*tpcps.dll

*GdiPlus.dll
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Component

Folders and files

$WINDIR%\system32
*InkEd.d1ll
*wisptis.exe

Note: These components are installed only on Tablet PCs.

Environment variable names are expanded to their actual values by the installer. For example, $CommonProgramFiles$ is expanded to C:

\Programs Files\Common Files.

Registry keys

The installer places any per-machine Mindjet registry settings in or below the key:
* HKEY_ LOCAL MACHINE\SOFTWARE\Mindjet\MindManager\VN (where VN is the application’s version number)

These are the settings used by the application and its add-ins on a per-machine basis. No per-user values are stored in this key.

Following Windows guidelines, the application registers its associated file types, COM objects, etc., in sub-keys of HKEY CLASSES_ROOT.

Key type

HKEY_LOCAL_MACHINE

HKEY_CLASSES_ROOT
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Location/Key

HKEY LOCAL MACHINE\SOFTWARE \Mindjet\MindManager
\VN

(where VN is the application’s version number)

HKEY CLASSES_ROOT\...

(all keys below this level)
*.mmap
*.mmas
*.mmat
*.mmbas
*.mmmp
*.mmms
*.mmp
».mdeck
* Mindjet.MindManager.Custom.Document
* Mindjet.MindManager.Document.x
* Mindjet.MindManager.Document.Template.x
* Mindjet.MindManager.Macro.x
* Mindjet.MindManager.MapMarker.x
* Mindjet.MindManager.MapMarkerSet.x
* Mindjet.MindManager.MapPart.x
* Mindjet.MindManager.Style.x
* Mindjet.Mm5GenericSmartMapPart.AddIn
* Mindjet.Mm5GenericSmartMapPart.AddIn.x
* Mindjet.Mm5Sort.AddIn
* Mindjet.Mm5Sort.AddIn.x
* Mindjet.Mm5WebExportAddin
* Mindjet.Mm5WebExportAddin.x
* Mindjet.Mm10ExcelLinker.AddIn.x
* Mindjet.Mm10ExcelLinker.AddIn
* Mindjet.Mm10MsProject.AddIn
* Mindjet.Mm10MsProject.AddIn.x
* Mindjet.Mm100utlook.AddIn



Key type Location/Key

* Mindjet.Mm100utlook.AddIn.x
* Mindjet.Mm100utlookLinker.AddIn
* Mindjet.Mm100utlooklinker.AddIn.x
* Mindjet.Mm10PPExport.AddIn

* Mindjet.Mm10PPExport.AddIn.x
* Mindjet.Mm10Project.AddIn

* Mindjet.Mm10Project.AddIn.x

* Mindjet.Mm10Word.AddIn

* Mindjet.Mm10Word.AddIn.x

* MindManager.Application

* MindManager.Application.x

* MindManager.Color

* MindManager.Color.x

* MindManager.TextFont

* MindManager.TextFont.x

* Mm5WebExport.Page

* Mm5WebExport.Page.x

* Mm5WebExport.Pages

* Mm5WebExport.Pages.x

* Mm5WebExport.VariantSets

* Mm5WebExport.VariantSets.x

* Mm5WebExport.WebExport

* Mm5WebExport.WebExport.x

* Mm5WebExport.WebExports

* Mm5WebExport.WebExports.x

* MM8InternetExplorer.BHO

* MM8InternetExplorer.BHO.x

Uninstall key HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Windows
\CurrentVersion\Uninstall

HKEY_CURRENT_USER HKEY CURRENT USER\Software\Mindjet\MindManager
\VN

(where VN is the application’s version number)

Uninstall information for the program is stored in a sub-key of:
* HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall

The name of the sub-key is the Globally Unique Identifier (GUID) for the program (which changes with each release). You can find it by using
RegEdit to search for MindManager in the Uninstall key. The uninstallation key does not remain after uninstalling.

When a user runs the application, any per-user registry settings are stored in or below the key:
* HKEY CURRENT USER\Software\Mindjet\MindManager\VN
(where VN is the application’s version number)

Some Current User keys remain after uninstalling. These keys help preserve user data for upgrading to the next version of MindManager.

What remains after uninstallation

When you uninstall, almost all traces of the application are removed, including all components located at C: \Program Files
\MindManager VN (where VN is the application’s version number). Most registry keys are removed as well. Map files (mmap files) are not
deleted.
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Remaining files, folders, and software components

When you uninstall, the installer leaves behind some components it installed with the program. The tables below reflect the most common
remaining components and registry keys. The actual list may vary depending upon the installation and deployment. In general, components
left behind fit one of these scenarios:

* User data (the library, images, and templates) remains to support upgrading to the next version or
* Shared components, such as C++ libraries, and their registry keys get left behind because they may be required for other purposes

or
* A backup of your registry

Component Location and explanation

Ink-related files For locations, see “Shared system software” on page 7.

These files may be in use by other applications.

msvcp60.dll $WINDIR%\system32

This software may be in use by other applications.

msvcrt.dll $WINDIRS\system32

This software may be in use by other applications.

XML-related files For locations, see “Shared system software” on page 7.

These files may be in use by other applications.

User Data C:\Users\ [username] \AppData\Local\Mindjet
\MindManager\VN (where VN is the application’s version
number)

Contains dictionaries, images, templates dictionaries etc. that the
user may have customized. Does not uninstall so the user does not
lose this data when upgrading.

Remaining registry keys

Registry key Location and explanation
HKEY_CLASSES_ROOT HKEY CLASSES_ROOT\
*.mmap
*.mmp
».mdeck

These keys register .mmap file extensions.

HKEY_CURRENT_USER HKEY CURRENT USER\Software\Mindjet\MindManager
\VN\ (where VN is the application’s version number)

Keys at or below this preserve user data for upgrading.
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Use the Admin setup

The Admin setup gives systems administrators more control over an installation. It is distributed in a .zip archive that contains the following
files:

*  MindManager VN.msi (where VN is the application’s version number)
The MindManager Microsoft installer.

* NDP462-KB3151802-Web.exe
Microsoft's .NET Framework redistributable setup.

* vcredist_ 2022 _x86.exe (for 32-bit or 64-bit running 32-bit) or vcredist_2022_x64.exe (for 64-bit)
Microsoft Visual C++ Runtime environment for version 2022.

* MicrosoftEdgeWebview2Setup.exe

Microsoft WebView2 Runtime. Install this component to enable enhanced embedded browser support based on Microsoft's Chromium
Edge Browser.

Using the Admin setup gives you nearly complete control over your deployment, including:
* Deploying (or not deploying) specific components

* Disabling functions, such as Internet access

» Storing components on network drives, such as user data or the library

You also have the option of configuring many items from the registry.

Required software

All required software is in included in the Admin setup package. It contains some software that must be installed on your system before
using the setup. You should verify that this software is already installed on your system; if not, install it from the Admin package.
* vcredist_ 2022 _x86.exe or vcredist_2022_x64.exe installs the VC++ Redistributable components for Visual Studio 2022.

Check for existence of registry key.

For vcredist_2022_x86.exe, the registry key is:

HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall\{13A4EE12-23EA-3371-91EE-
EFB36DDFFF3E}

For vcredist_2022_x64.exe, the registry key is:

HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall\{A749D8E6-
B613-3BE3-8F5F-045C84EBA29B}

Or simply re-install.
* vcredist_2022_x86.exe installs the VC+ + Redistributable components for Visual Studio.
Check the installed programs in the Control Panel to check existing installation.
* ndp48-web.exe installs the Microsoft Net 4.8 Framework
Check the installed programs in the Control Panel to check existing installation. This install can take quite a long time.

=¢

You should check for and install any missing components in the order listed above.

Required permissions and privileges
Administrator privileges are required to install any Windows software, including MindManager.

No special privileges or disk permissions are required to run the application. A user can run the program as a restricted user, a “normal” user,
a power user, or an administrator. The program does assume that the user has read/write/create privileges in the HKEY CURRENT USER
registry key as well as in the user profile section of the hard disk and below.
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Differences between the standard and Admin setups

The Admin setup is based on the standard setup—with a number of important differences:

* Caching: The Admin setup does not cache the setup on the computer where it is being installed. Instead, the setup should be run from
a network location that remains accessible from the workstation at all times. This ensures proper operation of the Modify, Repair, and
Remove entries in the "Add/Remove programs” Control Panel applet, and avoids duplication of the installation source on every system
where the application is installed.

* Patching: Admin setups are only delivered as full setups, not patch setups. The reason for this is that system administrators might modify
the Admin setup to suit the needs of their individual company. If the installation database is transformed in this way, a future patch
would not be able to properly update the installation. We avoid this problem by not delivering patch updates at all for our Admin setups.
To upgrade, you need to uninstall the previous version and install the upgrade.

* Packaging: We exclude the Microsoft Windows Installer engine and .NET Framework installer. Both components must be installed prior
to running MindManager.msi if they are missing from a user’s machine.

* User Data: The Admin setup includes the option to specify the location of user data.

* Library Files: There is also an option to have the application extract the library files as usual, or to have the administrator set this up
“manually,” ahead of time. For more information, see “Deploying user data and the Library to a server” on page 15.

Installation overview

This section gives an overview of the Admin Setup and application components. With this information, you can understand the installation
process and determine what you may wish to customize for your deployment.

Per-machine setup

The setup installs the program on a client machine and only sets per-machine registry settings in the HKEY LOCAL MACHINE and
HKEY CLASSES_ ROOT registry keys. It does not directly create or set any registry keys or values in the HKEY CURRENT_ USER
registry key.

The installer installs all program files to this default folder:
* C:\Program Files\MindManager VN (where VN is the application’s version number)

Administrator privileges are required to install any Windows software, including MindManager.

Per-user Setup

Each time the application launches, it checks the UserData.ini file, located in C: \Users\ [username] \AppData\Local\Mindjet
\MindManager\VN (where VN is the application’s version number) to determine if a per-user setup needs to be performed.

If this file is missing, or if the version of the application installed is newer than the version the user last ran, then MindManager prepares for
a "new” per-user installation by deleting the following registry key:

* HKEY CURRENT USER\Software\Mindjet\MindManager\VN\User Interface (where VN is the application’s version
number)

The application also determines if the per-user application data files (outline print templates and spell check auto-correct dictionaries) are
present. If not, it copies them from the "All Users” folder:

C:\Users\ [username] \AppData\Local\Mindjet\MindManager\VN (where VN is the application’s version number)

Finally, the application determines if the per-user Library files need to be installed using the same UserData.ini algorithm described above and
checks the LSDLibraryExtract. If the registry is not set to 0, then a separate background task/program is run to unzip the library files from a
MindManager sub-folder:

C:\Program Files\MindManager VN\sys\[language](where VN is the application’s version number)

Deploy with the Installation Wizard

Using the Admin setup to install the application is straightforward and simple. Unlike the basic setup, you have customization options,
though not as many as from the command line.
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To install the application

1 Launch the installer.

At the welcome screen, click Next.

Select | agree to the terms of the license agreement and click Next.
Enter the Customer Information (User Name and Organization).

Click Next.

The Setup Type dialog appears.

u & W N

15 Mindjet MindManager Setup ¥

Setup Type
MindManager ‘g

Please select a setup type.

(®) Standard

All program features will be installed.
Recommended for most users.

() Custom
Choose which program features you want installed and where they
will be installed.
InstallShield

At this point, you can customize your deployment or complete the installation. For more information, see “Customizing the installation” on
page 13 or “To complete the standard installation” on page 16.

Customizing the installation

A custom installation allows you to:

* Disable default features

* Change the default installation folder

* Deploy user data and the library on a separate server

If you need to customize the installation beyond these parameters, see “Deploy from the command line” on page 16.

To disable the default installation features

1 Complete steps 1-5 in “To install the application” on page 13.
2 Select Custom and click Next.
The Custom Setup dialog appears.

3 In the tree, select a feature whose default installation you want to change.
Click the down arrow button j

5 Select the desired feature setting.
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ﬁ Mindjet MindManager Setup *

Custom Setup
MindManager ‘-

Click on an icon in the list below to change how a feature is installed.

- Feature Description
& _Q.LI M|ndMan.ager ) The RSS Feeds allows you to display
Microsoft Add-ins RSS feeds in MindManager.
Dictionaries
R55 Feeds

=) This feature will be installed on local hard drive,

=8 This feature, and all subfeatures, will be installed on local hard drive,

¥ This feature will not be available.

Install to:
C:\Program Files\Mindjet\MindManaaer 19Y Change...
Advanced...
Installshield
Help Space < Back Cancel
For each selected feature, a description and storage requirement appears.
6 Repeat this process until you have made all of your feature customization choices.
7 Complete the installation as outlined in “To complete the standard installation” on page 16.
To change the default installation folder
1 Complete steps 1-5 in “To install the application” on page 13.
2 Select Custom and click Next.
The Custom Setup dialog appears.
ﬁ Mindjet MindManager Setup *
Custom Setup »

3 Click Change.

MindManager &

Click on an icon in the list below to change how a feature is installed.

- Feature Description
B _Q;I M|ndMan.ager ) The RSS Feeds allows you to display
=3 - | Microsoft Add-ins RSS feeds in MindManager.,
=) ~ | Dictionaries
This feature requires 486KE on your
hard drive.
Install to:
C:\Program Files\Mindjet\MindManaaer 19Y Change...
Advanced...
Installshield
Help Space < Back Cancel

The Change Current Destination Folder dialog appears.
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6

Select the destination folder.

Click OK.
The new destination folder appears in the Custom Setup dialog.

Complete the installation as outlined in “To complete the standard installation” on page 16.

Deploying user data and the Library to a server

MindManager installs a Library folder containing:

Background Images
lcons

Images

Map Parts

Shapes

Styles

Templates

Web Export Templates

The entire library consists of several megabytes. By default, these files are stored on a per-user basis in this folder: C: \Users
\ [username] \AppData\Local\Mindjet\MindManager\VN\Library\ [language](where VN is the application’s version number)

You can store user data and the library in a network folder for if you wish to:

Save space on users' systems

Decrease the time required to run the program the first time

Allow roaming user’s access to their customized libraries

Assure that all users have a fixed, easily updatable set of library files

You can install these files once to a common location (perhaps in a read-only folder). Multiple users can then share the files, or a single user
can access them from multiple machines. If a user needs to edit these files, install them in a directory with write privileges.

You cannot install user data and the library to separate locations from the installation wizard. To install them separately, you must install
them from the command line. For more information, see “Deploy from the command line” on page 16.

To deploy user data and the Library to a server

1

2

Complete steps 1-5 in “To install the application” on page 13.
From the Custom Setup dialog, click Advanced.

The Deploy User Data Files dialog appears.

Select Deploy user data on server.
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ﬁ Mindjet MindManager Setup *

Deploy user data files
MindManager ‘&

(") Install user data files on local disk

This is the recommended method for standard installations. User data files are installed into
the standard Windows per-user data location.

(®) Deploy user data on server

|Jse this method to store all user data files in a central server folder. Please make sure you
have read the large scale deployment installation document you can download from the
Mindjet website,

Server base path:

| Browse...

[JExtract library to the server path the first time MindManager starts

[Juse separate folders per user
Preview Path

Installshield

o |[o=]

4 Click Browse.
The Browse for Folder dialog appears.
5 Select the destination folder.
6 C(lick OK.
The new directory appears in the Server base path field.
7 Choose from the following options:
* Extract library to the server path the first time the application starts
* Use separate folders per user

We recommend selecting both of these options to avoid needing to configure the user data folder and the library folder separately. You
may want to create the user folders before installation, giving you the chance to make the files read only.

8 Click OK to close the dialog.

9 Complete the installation as outlined in “To complete the standard installation” on page 16.

These are all of the customization choices available from the installer interface. You have more control if you deploy from the command
line.

To complete the standard installation
1 Select Complete and click Next.
The Ready to Install dialog appears.
2 Choose your shortcut options.
Click Install.
4 After the installation is complete, choose from the following options:

w

* Launch MindManager
* Register MindManager
5 Click Finish.

Deploy from the command line

While you may wish to customize your deployment from the installer interface, you have much greater control over the installation from the
command line, including:
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* Configuring installation parameters

* Specifying what to install on a feature by feature basis
* Enabling or disabling program functions

* Specifying where to install libraries, and user data

* Using a custom SharePoint SiteConnections.xml file

This section identifies what you may configure and provides examples of command line arguments for customizing your deployment. A
sample installation command demonstrating most of these options is included in “Sample setup commands” on page 25.

To configure installation parameters from the command line

You can set a number of public properties with command line options.

Parameter Description of values
INSTALLDIR Specifies where the application should install the program. For
example:

C:\Program Files\MindManager VN\

(where VN is the application’s version number)

RESOURCELANGUAGE Specifies the Install language of MindManager.
Language values include:
*English
*German
*French

* Japanese
*ChineseSimplified
*Spanish

*Dutch

If a language parameter is not specified, MindManager will be
installed in the default Operating System language for the above
supported languages.

For example:

msiexec /i "<directory>\filename.msi"
RESOURCELANGUAGE="German" /qgn

LICENSEKEY Specifies the license key for your installation. No validation is
performed for this key; it is simply written to the registry.

For example:
LICENSEKEY=""e2c0163d-
xxxx-4844-8b99-6a5b82967faa""
USERNAME Specifies the User Name for the application.
Optional parameter; the Windows User Name will be used if this

parameter is not supplied.

COMPANYNAME Specifies the Company Name for registering the application.
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Parameter Description of values

Optional parameter; the Windows Company Name will be used if
this parameter is not supplied.

To configure features from the command line

The Admin setup is a Basic MSI project, not an Install Script project; there is no record mode to run an install with Setup.iss. Basic MSI
projects do not create or use a response file for silent installations.

C=

When configuring features from the command line, it is better to use /s silent installation to avoid conflicts with properties set
through the installer interface. You can remove or add features from the command line by using ADDLOCAL or REMOVE on a
feature by feature basis. To simplify the process, use ADDLOCAL="ALL" and then remove features you do not want. Examples are
provided below.

To customize the installation with Setup.exe

You can use the following options to add or remove features from the command line setup.exe:
/v=command line access to msi file
/gqn=when used with /v parameter, silent (no user interface) parameter passed to msi file

Here are examples of adding and removing features through the setup.exe file, using silent install:
Adding:

<directory>\setup.exe /v"ADDLOCAL=\"MSWordAddin\" /qgn"
Removing:

<directory>\setup.exe /v"ADDLOCAL=\"ALL\" "REMOVE=\"MSWordAddin\" /qn"
You can also string together multiple features for inclusion or removal:

<directory>\setup.exe
/v"ADDLOCAL=\"All\" REMOVE=\"MSWordAddin, RSS\" /qn"

To customize the installation with MSI

You can use these options to add or remove features from the command line with MSI.exe:
/i=install mode
/an=silent (no user interface) parameter
Tip: /an+ will let you know when it’s done

o

In Windows, security features require that you run silent install (/gn) as the Administrator, not as a member of the Administrator
group.

Here are examples of adding and removing features through the msiexec.exe file, using silent install:

Adding:
msiexec /i "<directory>\filename.msi" ADDLOCAL="MSWordAddin" /qgn

Removing:
msiexec /i "<directory>\filename.msi" ADDLOCAL="ALL" REMOVE="MSWordAddin" /qn

You can also string together multiple features for inclusion or removal:
msiexec /i "<directory>\filename.msi" ADDLOCAL="ALL" REMOVE="MSWordAddin, PDFWriter,RSS" /qgn
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Feature Comment

Library Available add-ins

The default add-in is Library, which installs add-ins below. You can
also specify a subset.
*Images
* Shapes
* Backgroundimages
*|cons
* ImageGallery
* TemplateOrganizer
* Templates
* WebTemplates
* Styles
* Map Parts
* Map Markers

Example:

msiexec /i "<directory>\filename.msi"
ADDLOCAL="ALL" REMOVE="WebTemplates" /qn

Microsoft Add-Ins Available add-ins:

The MSAddins feature is a container for the following Microsoft-
related add-ins. Any or all of these sub-features can be all installed
by specifying them on the command line. (Examples below clarify
this.)
* MSWord (for 32-bit) or MSWordAddin64 (for 64-bit)
* MSOutlookLinkerAddin (for 32-bit) or MSOutlookLinkerAddin64
(for 64-bit)
* MSOutlookMapMinderLinkerAddin (for 32-bit) or
MSOutlookMapMinderLinkerAddin64 (for 64-bit)
* MSProjectAddin (for 32-bit) or MSProjectAddin64 (for 64-bit)
* MSExcelLinkerAddin (for 32-bit) or MSExcelLinkerAddin64 (for
64-bit)
* MmExcel (for 32-bit) or MmExcel64 (for 64-bit)

Note: This MSAddins feature, and all sub-features, can be removed
with REMOVE= "MSAddins" but they cannot be added with
ADDLOCAL= "MSAddins"

Example:

There are three options for including a feature that's not installed:
* 1. Include the selected feature
¢ 2. Include the selected feature and all sub-features
* 3. Include the selected feature and then select sub-features
individually

Using ADDLOCAL="MSAddins" is equivalent to (1) above. However,
this causes no add-ins to be added since MSAddins is just a
container for other add-ins, and they need to be specified.

ADDLOCAL="MSAddins, MSExcellLinkerAddin,
MSOutlookLinkerAddin, MSProjectAddin,
MSWordAddin" or (for 64-bit version) ADDLOCAL="MSAddins,
MSExcellLinkerAddin64, MSOutlookLinkerAddiné64,
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Feature

To configure functions from the command line

Comment

MSProjectAddin64, MSWordAddin64" is equivalent to (2)
above.

Using a subset of MSOutlookLinkerAddin,
MSOutlookLinkerAddiné64; MSProjectAddin,
MSProjectAddin; MSWord, MSWord is equivalent to (3)
above.

During installation, you can disable some functions by setting the value to “0.” For example:
msiexec /i "<directory>\MindManager VN.msi" /qn ONLINEHELP="0"

(where VN is the application’s version number)

Parameter

Macro Support

Shortcuts

Internet Access

Online Help
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Description of values

The function name is MACROUTI.
Example (msi):

msiexec /i "<directory>\MindjetAdmin.msi" /qn
MACROUI="0"

The function names are:
* SHORTCUTDESKTOP
* SHORTCUTSTARTMENU

Example:

msiexec /i “<directory>\MindManager VN.msi" /qgn
SHORTCUTSTARTMENU="0"

(where VN is the application’s version number))

The function name is INTERNETACCESS.
Example (msi):

msiexec /i “<directory>\MindManager VN.msi" /qgn
INTERNETACCESS="0"

(where VN is the application’s version number)
Example (setup.exe):

<directory>\setup.exe /s /v"INTERNETACCESS=0 /
qn"

The function name is ONLINEHELP.

Example (msi):

msiexec /i “<directory>\MindManager VN.msi" /qn
ONLINEHELP="0"



Parameter

Ul Customization

Disable Attachments

Disable Product Notifications

Disable Refresh Map Roll-up on Open

Proxy Options

Description of values

(where VN is the application’s version number)
Example (setup.exe):

<directory>\setup.exe /s /v"ONLINEHELP=0 /gqn"

The function name is UICUSTOMIZATION.
Example (msi):

msiexec /i “<directory>\MindManager VN.msi" /qn
UICUSTOMIZATION="1"

(where VN is the application’s version number)

Example (setup.exe):

<directory>\setup.exe /s /v"UICUSTOMIZATION=1 /
an"

The function name is DISABLEATTACHMENTS.

Example (msi):

msiexec.exe /i “<directory>\MindManager VN.msi"
DISABLEATTACHMENTS="1" /qn

(where VN is the application’s version number)

The function name is PRODUCTNOTIFICATIONS.
Example (msi):

msiexec.exe /i “<directory>\MindManager VN.msi"
PRODUCTNOTIFICATIONS="0" /qgqn

(where VN is the application’s version number)

The function name is REFRESHMAPROLLUP.
Example (msi):

msiexec.exe /i “<directory>\MindManager VN.msi"
REFRESHMAPROLLUP="1" /qgn

(where VN is the application’s version number)

The function name is PROXY_TYPE=X.

Where X can be following:
*0 = no proxy
*1 = Use default windows settings
* 2 = Use custom proxy settings

Example (msi):
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Parameter Description of values

msiexec.exe /i “<directory>\MindManager VN.msi"
PROXY TYPE=X /qn

(where VN is the application’s version number)

Custom Proxy setup The function name is PROXY_TYPE=2.
PROXY_HOST="host name"
PROXY_PORT=port number
PROXY AUTHENTICATION=can be O or 1(0 to disable)
PROXY SAVECREDENTIALS=can be 0 or 1(0 to disable)
Example (msi):

msiexec.exe /i “<directory>\MindManager
VN.msi" PROXY_IYPE=2 PROXY_ﬂOST="hOSt name"
PROXY_PORT=port name PROXY_AUTHENTICATION=1
PROXY_SAVECREDENTIALS=1 /an

(where VN is the application’s version number)

Disable HTML5 Template Updater The function name is ALLOW_HTML5_TEMPLATE UPDATE.
Example (msi):

msiexec.exe /i “<directory>\MindManager VN.msi"
ALLOWHTML5TEMPLATEUPDATE=0 /qn

(where VN is the application’s version number)

To enable Jira Linker

You may want to enable the Jira linker whether or not Internet access is enabled. For more information about Internet access, see Internet
Access

Jira Linker options

Command

JiraCloudAccessOverride="1" When InternetAccess =0 (and its corresponding registry value,
InternetConnectionEnabled), access to Jira Cloud still
enabled.

JiraDataCenterAccessOverride="1" When InternetAccess =0 (and its corresponding registry value,
InternetConnectionEnabled), access to Jira Data Center still
enabled.
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To deploy user data and the library

You may want to deploy user data and the library to a server. For more information, see “To deploy user data and the Library to a server” on

page 15.

If you want to deploy the user data and library on separate servers, you must do so from the command line or by editing the registry.

Deploying user data and the Library from the command line

The following commands give you the ability to deploy user data and the Library to separate locations. Each option consists of a property,
which (when given a command line value) writes to the registry. You can also predefine these options by creating and executing a registry

script before a silent setup.

User data deployment options
Command

USERDATAPATH="<user specified path>"

USERDATAPERUSERPATH="1"

USERDATAPATHSUFFIX="<user specified path>"

Example:

Resulting registry entry

HKEY LOCAL MACHINE\SOFTWARE\Mindjet\MindManager
\VN\Installer "LSDUserDataPath" "<user specified
path>"

(where VN is the application’s version number)

Deploy user data in a per-user folder.
1=Enable
0=Default or disable

HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager
\VN\Installer "LSDUserDataPerUser" (1)

(where VN is the application’s version number)

This folder is appended to the per-user folder.

HKEY LOCAL MACHINE\SOFTWARE\Mindjet\MindManager
\VN\Installer "LSDUserDataPathSuffix" "<user
specified directory>"

(where VN is the application’s version number)

msiexec /i "MindManager VN.msi" USERDATAPATH="C:\Temp\UserData" USERDATAPERUSERPATH="1"

USERDATAPATHSUFFIX="MyUserData"
(where VN is the application’s version number)

Library deployment options
Command

LIBRARIESPATH="<user specified path>"

Resulting registry entry

HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager
\VN\Installer "LSDLibraryPath" "<user specified
path>"

(where VN is the application’s version number)
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Library deployment options Resulting registry entry
Command
LIBRARIESPERUSERPATH="1" Deploy libraries in a per-user folder.
1=Enable
0=Default or disable

HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager
\VN\Installer "LSDLibraryPerUser" (1)

(where VN is the application’s version number)

LIBRARIESPATHSUFFIX="<user specified directory>" This folder is appended to the per-user folder.

HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager
\VN\Installer "LSDLibraryPathSuffix" "<user
specified directory>"

(where VN is the application’s version number)

LIBRARIESEXTRACT="1" Extract libraries to path the first time the application starts.
1=Enable
0=Default or disable

HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager
\VN\Installer "LSDLibraryExtract" (1)

(where VN is the application’s version number)

Example:

msiexec /i "MindManager VN.msi" LIBRARIESPATH ="C:\Temp\Libraries" LIBRARIESPERUSERPATH ="1"
LIBRARIESPATHSUFFIX ="MyLibraries" LIBRARIESEXTRACT="1"

(where VN is the application’s version number)

To deploy user data from the registry

During a silent (non-interactive) installation, you can deploy data user files by setting some registry values on the user's system in the registry
key before running the installer:
HKEY LOCAL MACHINE\SOFTWARE\Mindjet\MindManager\VN\Installer

(where VN is the application’s version number)

Registry value Data value

LSDUserDataPath Examples:
N:\User Data\All Users\Mindjet\MindManager\
or

N:\User Data (if LSDUserDataPerUser is set to 1)

LSDUserDataPerUser 1 = Do not use separate folders per user
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Registry value Data value

0 = Do use separate folders per user

LSDUserDataPathSuffix See above.
Example:
Mindjet\MindManager\VN
(where VN is the application’s version number)

Only applies if LsDUserDataPerUser is set to 1

If you want to deploy all of the user data (including the library) on a server, create a registry file named MindManager Large-Scale
Deployment Options.reg like this:
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet]
[HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager]
[HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\VN]
[HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\VN\Installer]
"LSDUserDataPath"="N:\\User Data\\All Users\\Mindjet\\MindManager VN"
"LSDUserDataPerUser'"=dword: 00000001
"LSDUserDataPathSuffix"="User Data"
“LSDLibraryPath= N:\\All Users\\Mindjet\\MindManager VN”
"LSDLibraryPerUser"=dword:00000001
"LSDLibraryPathSuffix"="Library"
"LSDLibraryExtract"=dword:0000001
(where VN is the application’s version number)

Sample setup commands

The following section provide sample commands to demonstrate various installation scenarios.

Simple installation

This command simply runs the installer in the usual interactive mode.
Msiexec.exe /i "MindManager VN.msi"
(where VN is the application’s version number)

You can also run MindManagerAdmin.msi from File Explorer.

Silent installation

This command silently runs the installer, supplying values for all required parameters.
Msiexec.exe /i "MindManagerAdmin.msi" /qn INSTALLDIR="C:\Program Files\MindManager VN\"

(where VN is the application’s version number)

Uninstallation

This command uninstalls the application:
Msiexec.exe /x "MindManager VN.msi"
(where VN is the application’s version number)
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Deploy with Active Directory

Deploying via Active Directory and Group policies has limited supported at this time because:

* The setup only supports computer-based software installation
* Some properties can only be configured from the command line

You can use configuration tools such as Orca to:
* Configure properties from the property table
* Save the settings to a transform file (MST)

* Deploy it with the updated values

The following properties can be modified in the Property Table:

Property

INTERNETACCESS=1/0

LIBRARIESPATH= < defaultpath>

LIBRARIESPATHSUFFIX= <defaultpath>

LIBRARIESPERUSERPATH=0/1

LIBRARIESEXTRACT=1/0

USERDATAPATH= <defaultpath>

USERDATAPATHSUFFIX= <defaultpath>

USERDATAPERUSERPATH=0/1

MACROUI=1/0

ONLINEHELP=1/0

REBOOTISREQUIRED=No/Yes

TOPICALERTSLINKER=1/0
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Description/Defualt setting

Allow Internet access
eDefault = 1

User can override default path.

User can override default path.

Deploy libraries per user
*Default = 0

Extracts libraries at first launch
eDefault = 1

User can override default path.

User can override default path.

User Data deployed per user
*Default = 1

Enable Macros in Ul
e Default = 1

Enable online Help
*Default = 1

Require reboot after installation
* Default = No

Enable topic alerts linker
eDefault = 1



Property Description/Defualt setting

UICUSTOMIZATION=1/0 (default=1) Enable Ul customization
eDefault = 1

SHORTCUTDESKTOP=1/0 Create Desktop shortcut
eDefault = 1

SHORTCUTSTARTMENU=1/0 Create StartMenu shortcut
eDefault = 1

Recommendations:
* Save these settings to the transform file as a backup, rather than directly to the MSI.

* Deploy on a per-machine basis only, avoiding the possibility that the machines with multiple users get multiple copies of the application
installed.

* Create a policy for Always install elevated, otherwise the installation may fail.

Administer MindManager

There are other administrative issues involved in deploying on a large scale. You can address many of them using the administrative tools and
methods described below.

To disable Zapier

To set this HKLM registry entry to 0 use the following command:
msiexec /i "MindManager VN.msi" ZAPIERENABLED="0" /qgn+
(where VN is the application’s version number)

The above example creates:
HKLM\ SOFTWARE\Mindjet\MindManager\VN\Settings\ZapierEnabled
(where VN is the application’s version number)
with a value of 0 (disabled), otherwise this key is not created by the installer at all.

=

When a 32-bit installer is run on a 64-bit operating system, there is a Wow6432Node component added to the above registry
entry. In this case, the HKEY looks like this:

* HKLM\ SOFTWARE\Wow6432Node\Mindjet\MindManager\VN\Settings\ZapierEnabled
(where VN is the application’s version number)

To manage Add-Ins

The application uses a number of add-in DLLs. The Add-Ins are automatically registered when the application is installed. On startup, the
Add-Ins check for any other required resources (e.g. the supported version(s) of Microsoft Word). They enable or disable themselves as
appropriate. If an add-in fails to start, it is automatically removed from the list of add-ins (but not from the disk).

To unregister the Word add-in from the command line

1 Select Start » Run.

2 Enter the command:
regsvr32 /u "C:\Program Files\MindManager VN\Mm20Word.dl1l"

(where VN is the application’s version number)
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To restore an unregistered add-in from the command line

1 Select Start » Run.
In this example, the Word add-in is restored.

2 Enter the command:
regsvr32 "C:\Program Files\MindManager VN\Mm20Word.dll"
(where VN is the application’s version number)

To manage Add-Ins from the registry

Users can enable and disable add-ins using the Tools » Add-Ins command. However, if desired it is possible to disable or remove individual
add-ins via the Windows registry.

To locate the registry Add-In List

The list of add-ins that load at startup can be found in the registry at:
HKEY LOCAL MACHINE\SOFTWARE\Mindjet\MindManager\VN\AddIns
(where VN is the application’s version number)

To remove or restore Add-Ins from the registry
* To remove an add-in, delete its registry subkey.
* To remove the Word add-in, delete the following key:
HKEY LOCAL MACHINE\SOFTWARE\Mindjet\MindManager\VN\AddIns\Mindjet.MmWordAddIn.21
(where VN is the application’s version number)
This makes the add-in “invisible” to the application so it will not be loaded on program startup and will not be seen in the list of add-ins
in the Tools P Add-Ins dialog. However, the add-in DLL files still exist on the hard drive.

2
N
N

)

You can also remove an add-in by unregistering it. For more information, see “To manage Add-Ins” on page 27. It is not
recommend to delete the add-ins’ DLLs because they will be restored automatically the next time the program is run using its
shortcut.

To enable or disable Add-Ins from the registry

Users can disable or enable a given add-in directly using the Tools » Add-Ins command. Add-ins can also be disabled using the Windows
registry as described below.

There are two keys to consider when disabling an add-in for a given user:
HKEY LOCAL MACHINE\SOFTWARE\Mindjet\MindManager\VN\AddIns\AddInName
HKEY CURRENT USER\Software\Mindjet\MindManager\VN\AddIns\AddInName

Where AddInName is the actual name of the add-in, for example Mindjet. MmWordAddIn.VN, and where VN is the application’s
version number.

When a given user starts the application, the program checks first in the HKEY CURRENT_USER subkey for a LoadBehavior value. If it
exists, it is used.

If the LoadBehavior value does not exist, the application copies the LoadBehavior value from the HKEY LOCAL MACHINE subkey to
the HKEY CURRENT USER subkey and then uses that value.

Therefore, to disable an add-in for the current user, set the LoadBehavior value in the HKEY CURRENT USER subkey to 0.
To disable the add-in for all new users, set the LoadBehavior value in the HKEY_LOCAIL MACHINE subkey to 0.
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This has no effect on users that have already run the application at least once. For them you must set LoadBehavior in the
HKEY CURRENT USER subkey.

Similarly, setting LoadBehavior to 2 enables the add-in again.
To manage Microsoft Office add-ins

When the application is installed, it registers add-ins for Microsoft Office products. The location of this add-in registration in the Windows
registry depends on the application and the add-in.

=¢

Microsoft Word handles the Tools » COM Add-Ins command and user interface differently than MindManager.

* In Microsoft Word, if an add-in is registered in HKEY LOCAL MACHINE (HKLM), then it is not displayed in the COM Add-
Ins dialog.

* If an add-in is registered in HKEY CURRENT USER (HKCU), it is displayed in the dialog and can be turned off and on.
e If the add-in is registered both in HKLM and HKCU, Microsoft Word ignores the HKCU entry and just uses the HKLM entry.

The registry data values for the Microsoft program add-ins are the same as described for the add-ins and can be edited in a similar
fashion.

To manage from the registry

To allow system administrators to control the environment presented to their users, the application supports registry settings, which can be
set via the user interface. However, registry settings relevant to large-scale deployment are not available from this user interface. See also
"User configuration files” on page 7, which are similarly adjusted using registry settings.

HKEY_LOCAL_MACHINE settings

The following registry settings are used on a per-machine basis:
HKEY LOCAL MACHINE\SOFTWARE\Mindjet\MindManager\VN\Settings
(where VN is the application’s version number)

Value name/Type Value data

LocalUserDataDirectory/REG SZ Path to copy user data files (e.g. Image Library files, etc.) at first
launch. May contain environment variables.

For example:
N:\UserData\%USERNAMES%\MindManager VN
(where VN is the application’s version number)

If no path is specified, then this path is assumed:
$USERPROFILE%\Local Settings\
Application Data\MindManager\VN

This setting can be overridden by the same setting in
HKEY CURRENT_ USER or by the LSDUserDataPath setting
described earlier.
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HKEY_CURRENT_USER Settings

The following registry settings are used on a per-user basis:

HKEY CURRENT USER\Software\Mindjet\MindManager\VN\Settings

(where VN is the application’s version number)

Value name/Type

AllowUpdateCheck/REG_DWORD

DisableAnimation/REG_DWORD

LocalUserDataDirectory/REG_SZ

To manage with Event Macros

Value data

0 to hide the Help, Check for Updates command.
1 to show this command.

2 to show this command only if the user has write privileges to
HKEY LOCAL MACHINE (default)

0 to allow animation of maps for smoother scrolling.

1 to disable animation of maps for one-jump scrolling, which is less
graphics intensive and perhaps more desirable in a low-bandwidth
Windows Terminal Server environment.

Path to copy user data files (e.g. Image Library files, etc.) to when a
new user first launches. May contain environment variables.

For example:
N:\UserData\%USERNAME%\MindManager VN
(where VN is the application’s version number)

If no path is specified, then this path is assumed:

$USERPROFILE%\Local Settings\Application Data
\MindManager\VN

This setting can be overridden by the LSDUserDataPath setting
described earlier.

The application can trigger certain Event Macros that can help system administrators monitor the usage of the program more carefully.

* These macros are examples only. You need to customize them for your environment.

* Microsoft added the Outlook Object Model Guard starting with Outlook version 2002, forcing the display of an alert message informing
the user that a program is trying to access or send a message via Outlook, which the user must approve before proceeding. This behavior

can be controlled by Outlook system policies.

Event name

OnApplicationStarted

OnExpiredTrialStarted
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When fired

At the end of Initinstance (only when started in “normal” mode,
not /RegServer, /UnregServer, etc.)

Just before the “Trial Expired” dialog



Event name When fired

OnFirstUse Just before installation of “per-user data”

OnBuyButtonPressed Just before the “Buy MindManager” dialog is displayed

When a macro event is fired, O or more macros are run. The mapping of macro event names to macro filenames is determined on startup.

On startup, the application looks in the registry at HKEY LOCAL MACHINE\SOFTWARE\Mindjet\MindManager\VN (where VN is the
application’s version number) for a key named Event Macros. If it is found, expect to find keys such as these:

Event Macros\
OnApplicationStarted\
EventMacro_OnApplicationStarted.mmbas

EventMacro_OnApplicationStartedTwo.mmbas

Path="C:\Temp\EventMacro OnApplicationStartedTwo.mmbas"
OnBuyButtonPressed\

EventMacro_OnBuyButtonPressed.mmbas
OnExpiredTrialStarted\

EventMacro OnExpiredTrialStarted.mmbas

OnFirstUse\

EventMacro_OnFirstUse.mmbas

Each event key can have 0 or more macro key names. Each macro key can have an optional “Path” value.
e If the “Path” value is not there, then the key name is the path.

* If the path is a relative path (for example, "EventMacro_OnApplicationStarted.mmbas"), it is converted to an absolute path
relative to the default macro folder for the user (for example, 'C: \Documents and Settings\username\Local Settings
\Application Data\Mindjet\MindManager\VN\macros").

(where VN is the application’s version number)

If the “Event Macros” key is not in the registry, then the application looks for event macros in the default macro folder (see above) with a
name of the form:

EventMacro_<EventName>.mmbas

For example:
EventMacro_OnApplicationStarted.mmbas

Therefore, it is possible to get macro events to run a macro simply by putting macros with the proper name in the user's macro folder.
However, for most typical IT uses, the “Event Macros” key will be used, since this can point to macros on a network drive, for example.

For example, this "EventMacro_OnApplicationStarted.mmbas" macro uses the Outlook object model to send a notification email:
'#Uses "EventMacro Utilities.mmbas"
Sub Main
SendNotificationEmail "MindManager event: Application Started"
End Sub

Where the “EventMacro_Utilities.mmbas” file contains:
' Utilities for use with MindManager event macros
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Public Sub SendNotificationEmail (eventString As String)
' Sends the subject string to the appropriate IT person
' to notify them of the MindManager event that just occurred

' Get access to our email program

Dim outlookApp As Outlook.Application

Set outlookApp = New Outlook.Application

' Create a message

Dim message As Outlook.MailItem

Set message = outlookApp.Createltem(olMailItem)
message.To = "System Administrator"
message.Subject = eventString

message.Body = eventString

' Send the message
message.Send
End Sub

To install MindManager Linker for SharePoint

MindManager Linker for SharePoint supports an optional silent argument for deploying a SharePoint SITECONNECTIONFILE as a way to pre-
populate custom SharePoint connections.

Optional silent install argument:
SITECONNECTIONFILE=full path_to_custom site_connection_ file

This file can have any name but must be reachable from install-to machine. The file is copied to SiteConnections.xml in the SharePoint
Linker INSTALLDIR.

=4

This argument will have no operational effect when the application runs if the SharePoint Add-In is not active.

Proxy Server Support

The application supports proxy server connections to the internet, including overriding default Microsoft Internet Explorer settings.
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MindManager Options X

General Proxy Settings

;‘;'{" Proxy type:

Visual Effects (O No proxy

SDEHI&fEEVE (®) Use default Windows settings
ser In

Notes (O HTTRHTTPS:

Spelling

Review

Alerts & Security

Add-Ins

Transformations

Package Folders [ User name and password are required

Mindjet Files & Tasks

Task Info

Filter

Box
SharePaoint

Remember username and password between application sessions

Test

Cancel

Primary path:

1. In MindManager, click the File tab, click Options, and then click Proxy Settings.

2. Choose Auto-detect/Use system proxy settings (e.g. set by system or w/in IE) or Manual proxy configuration (no proxy, https).
3. Set proxy settings for manual proxy configuration.

Alternate path:

1. System administrator sets proxy settings (Host & Port) for Large-Scale Deployment.

2. When installed, MindManager options are configured based upon on System Administrator user's configuration.

3. System Administrator has an option to hide the ability to remember Username and Password for the HTTPS proxy settings.

Impacted areas:

* Online (Files) -, Sign in/out, and Tasks.

* Notifications; Creating/deleting files; folders, Co-editing and Sharing.
* Trial display messages emanating from Mindjet servers.

*  Tasks

* Connection — sign in/sign out

* Check for updates

* All the web services Map Parts

* SharePoint add-in

* Database linker

—¢

To use MindManager with Microsoft SharePoint, you must purchase and install MindManager Enterprise.

Registry settings

HKEY LOCAL MACHINE\SOFTWARE\Mindjet\MindManager\VN\Settings\ProxyType = 0 (no proxy) - DWORD type
(where VN is the application’s version number)
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1 = Use default windows settings; 2 = Use custom proxy settings

For custom proxy types:

HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\VN\Settings\ProxyHost = host name - STRING

HKEY LOCAL MACHINE\SOFTWARE\Mindjet\MindManager\VN\Settings\ProxyPort = port name - DWORD

HKEY LOCAL MACHINE\SOFTWARE\Mindjet\MindManager\VN\Settings\ProxyAuthenticationRequired - DWORD (can
be 0 or 1)

HKEY LOCAL MACHINE\SOFTWARE\Mindjet\MindManager\VN\Settings\ProxySaveCredentials - DWORD (can be 0
or 1) - is used to save proxy credentials across application sessions

(where VN is the application’s version number)

Manage MindManager Apps
A MindManager App is a small extension to MindManager for Windows.

The MindManager Apps feature uses pre-existing MindManager features, eliminating any new vectors for introducing malware.
MindManager Apps use MindManager macros and attachments in MindManager maps, both of which are established features.
MindManager maps that contain attachments — including macros and executables — are available online.

Macros and attachments can already be disabled by an administrative installation procedure, but keep in mind:

* If macros and attachments are permitted, disabling MindManager Apps does not increase security.

* Disabling attachments would prevent MindManager Apps from being shared. An individual user could still create and run personal Apps,
but wouldn’t be able to create shareable Apps.

* Disabling MindManager macros limits Apps to being to being content-based only. Macros are used to extend the functionality of
MindManager, for example to implement a custom export from MindManager. Content-only Apps are viable and are a design choice.

App Sharing maps

Apps are transferred between users in App Sharing maps. These are regular MindManager maps containing the files needed by an App as
topic attachments, with additional metadata to identify them as App Sharing maps. These maps can be browsed like regular MindManager
maps, so their contents are not concealed. When an App is added to a MindManager client, its attachments are copied to the user’s
documents area:
* C:\Users\username\AppData\Local\Mindjet\MindManager\VN\MindManager Apps

(where VN is the application’s version number, 24 or later)

This allows MindManager to discover and load an App. There are no system-level registry keys involved and no Windows-level package
installation. To add and remove Apps, you only need to configure the user’s local data.

To verify the integrity of App Sharing maps, they can be signed with a hidden checksum. When the user adds an App, a dialog box appears,
showing whether the App Sharing map

* s correctly signed (displaying the author’s identity). Signed Apps are created with a restricted App developer license key. These keys can
be made available to trusted developers. Currently only Alludo, Harport Consulting, and Olympic Limited can sign App Sharing maps.
An App can be signed on behalf of another developer after reviewing its contents to ensure that there are no undesirable components.
Once signed, the developer cannot amend the App Sharing map without it requiring to be signed again. The example Apps hosted on
the MindManager web site are all signed.

* s unsigned. Unsigned App Sharing maps are refused by default, but the user can choose to change their local configuration options to
permit unsigned Apps to be added. This means that unsigned Apps are never added unintentionally. The user needs to take deliberate
action to add an unsigned App. This option can be blocked by an administrative installation, denying users the ability to add unsigned
Apps.

* has an invalid signature. An App Sharing map with an invalid signature arises from incorrect build procedure or from tampering with the
App Sharing map after signing it. The checksum protects the App configuration data and all attachments.
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Note: An App Sharing map with an invalid signature will be refused and cannot be added to the MindManager client.

The MindManager Apps feature in MindManager (version 24 or later) is implemented as an Add-in, which can be managed withing the
application (File tab » Options » Add-Ins » MindManager Apps). This provides the runtime platform for Apps and includes the tools
needed to author Apps. All code in this Add-in is original, and no components from third parties have been used.

License key

A separate license key is required for App authoring. MindManager’s license key does enable this feature. The App authoring tools are
hidden by default and only active when an App developer license key is present. An administrative installation can block the entry of a
developer license key, preventing users from creating their own Apps.

The MindManager Apps Add-in does not require Internet access and does not collect or transmit any data itself. The App developer license
key does not depend on online access for verification. It is bound to the user’s email address as entered in MindManager's options.

Custom Apps may use Internet access and may transmit or receive data. This should be made transparent to the user as part of good
practice with Apps.

MindManager Apps are designed for use in high-trust environments, such as within an organization, or between a consultant and their
clients. They are not designed for creating publicly available products. Their architecture and data are open, and MindManager macros are
not compiled so everything can be inspected.

Administrative Registry Keys and Values

The behavior and user permissions for Apps can be configured by an administrative installation process for the MindManager client. The user
can be prevented from using Apps, or specific features of Apps can be suppressed with HKLM registry entries.

To disable MindManager Apps from the registry
* The MindManager Apps feature can be disabled at installation time with the command line flag
¢ INSTALLMINDMANAGERAPPS="0"

To configure MindManager Apps behavior

* If MindManager Apps are enabled, the detailed behavior of the add-in can be controlled with REG_SZ values placed in the key:
* HKLM\Software\Mindjet\MindManager\VN\Installer
(where VN is the application’s version number, 24 or later)

Value Description

AppsMenu_HasAboutMenu 0=Default. No About command appears in the MindManager

Apps drop-down in the application (Advanced tab P
MindManager Apps)

1=The About command displays, which provides information
about the MindManager Apps platform.

AppsMenu_HasMacros 0=Apps are not permitted to use macros. Macros in button actions
and events are ignored.

1=Default. Apps can run macros

AppsMenu_CanGateway 0=Gateway Apps that unlock additional menu buttons are not
permitted.

MindManager for Windows large-scale deployment (online mode) | 35



Value

AppsMenu_HasAddMenu

AppsMenu_HasOptionsMenu

AppsMenu_AppsFolder

AppsMenu_CanEditAppsFolder

AppsMenu_CanAddRemove

AppsMenu_CanEditAddUnsigned

AppsMenu_CanUpdate

AppsMenu_CanEnableDisable
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Description

1=Default. Gateway Apps can unlock additional buttons and

submenus in MindManager Apps drop-down (Advanced tab P
MindManager Apps).

0=Default. No Add/Update App command appears in the
MindManager Apps drop-down in the application (Advanced tab

» MindManager Apps)

1=Add/Update App command appears in the MindManager Apps
drop-down, which allows users add or update Apps.

0=No Options command appears in the MindManager Apps
drop-down in the application (Advanced tab » MindManager
Apps)

1=Default. Options command appears in the MindManager Apps
drop-down, which allows users to configure Apps and options.

An explicit path to the Apps folder.

The default is Documents\MindManager Apps, where Documents
is the user’s Documents folder.

0=The user is not permitted to change the Apps folder in
the Manage Apps and Options dialog box (Advanced tab P
MindManager Apps P Manage Apps and Options).

1=Default. The user can change the location of the Apps folder in
the Manage Apps and Options dialog box.

0=The user is not permitted to add and remove Apps.

1=Default. The user is permitted to add and remove Apps.

0=The user is not permitted to configure the options to allow
unsigned Apps to be added.

1=Default. The user can change their options to allow unsigned
Apps to be added.

0=The user is not allowed to update installed Apps.

1=Default. The user can apply an update to an already installed
App.

0=The user is not allowed to disable or enable Apps.

1=Default. The user can disable and enable Apps in the Manage
Apps and Options dialog box (Advanced tab » MindManager
Apps » Manage Apps and Options).



Value Description

AppsMenu_HasHelpMenu 0=No Apps Help command appears in the MindManager Apps
drop-down in the application (Advanced tab » MindManager
Apps P Apps Help or File tab P Help » Apps Help).

1=Default. The Apps Help command appears in the
MindManager Apps drop-down, which opens the file defined by
AppsMenu_HelpFile.

AppsMenu_HelpFile The path to the Help file displayed at Advanced tab P
MindManager Apps P Apps Help or File tab P Help P Apps Help.

AppsMenu_HasSupportMenu 0=Default. No Support command appears in the MindManager
Apps drop-down in the application (Advanced tab »
MindManager Apps » Support).

1=The Support command appears in the MindManager
Apps drop-down, which opens the file defined by
AppsMenu_SupportFile.

AppsMenu_SupportFile The path to the support file displayed at Advanced tab P
MindManager Apps » Support.

AppsMenu_HasLicenceMenu 0=Default. No License command appears in the MindManager
Apps drop-down in the application (Advanced tab »
MindManager Apps P License).

1=The License command appears in the MindManager Apps
drop-down, which permits an App Studio license key to be
obtained and entered.

Note: This menu command is also enabled if a license key is already
present.

AppsMenu_LicenceFile The path to the file or the URL opened when the user clicks on Get
License in the License submenu, if enabled.

=

The Get MindManager Apps command appears by default (Advanced tab » MindManager Apps P Get MindManager Apps). In
App Studio v2.19 there is no registry value to control the display of this command. A registry value (HasGetAppsMenu) to control
it will be added in a later version.

Treat UNC Paths as SharePoint servers

If enabled, the Treat UNC paths as SharePoint servers option checks to see if the network location you open a map from is a SharePoint
server. If it is, then MindManager offers options for document check-out and check-in in the File P Info menu.This check can cause a slight

delay on opening documents, so it is disabled by default. If you are not opening maps from SharePoint servers, you should disable it for best
performance.
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Administrators can enable it using the registry or from the command line; users can enable it using MindManager’'s Options.

To enable from the command line
* ENABLEUNCPATH_CU
* 0 = Disable for the current user running the installation
* 1 = Enable for the current user running the installation
* ENABLEUNCPATH_LM
* 0 = Disable for local machine
* 1 = Enable for local machine

To enable using the registry
¢ HKEY CURRENT USER

* Value name: EnableUncPathDmsSupport ; Type: REG DWORD ; 0 to disable, 1 to enable
¢ HKEY LOCAL MACHINE

* Value name: EnableUncPathDmsSupport ; Type: REG DWORD ; 0 to disable, 1 to enable

To enable from MindManager

1 Click File tab » Options, and choose Open & Save.
2 Enable the Treat UNC paths as SharePoint Servers check box.
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